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1. Important

Ce guide électronique de ['utilisateur est
congu pour toutes les personnes qui utilisent
le moniteur de Philips. Prenez le temps de lire
ce Manuel d'utilisation avant d'utiliser votre
moniteur: Il contient des informations et des
notes importantes au sujet de I'utilisation de
votre moniteur.

La garantie Philips s'applique a la condition que
le produit soit manipulé correctement pour
son utilisation prévue et conformément aux
instructions d'utilisation, et sur présentation

de la facture d'origine ou du ticket de caisse
d'origine, indiquant la date de I'achat, le nom du
revendeur ainsi que le modele et le numéro de
production du produit.

1.1 Précautions de sécurité et
d'entretien

D Avertissements

Lutilisation de touches de réglages, d'ajustements
ou de procédures différentes de celles qui sont
décrites dans ce manuel pourrait présenter un
risque de choc électrique, d'électrocution et/ou
mécanique.

Lorsque vous connectez et utilisez le moniteur
de votre ordinateur, lisez et respectez les
consignes suivantes :

Utilisation

*  Veuillez protéger le moniteur de la lumiere
directe du soleil, des forts éclairages et
ne l'utilisez pas a proximité de sources
de chaleur. L'exposition prolongée a
ces types d'environnement peut causer
des dommages au moniteur et une
décoloration.

+  Eloignez tout objet pouvant tomber dans
les orifices de ventilation ou empécher le
refroidissement correct des composants
électroniques du moniteur.

*  N'obstruez pas les orifices de ventilation
du boftier.

* Lors de la mise en place du moniteur,
veillez a ce que la fiche d'alimentation et la
prise soient facilement accessibles.

¢ Sivous mettez le moniteur hors tension
en débranchant le cable secteur ou le
cable d'alimentation CC, attendez 6
secondes avant de rebrancher ces cébles.

» Utilisez toujours le cordon secteur
fourni par Philips. Si le cordon secteur
est manquant, veuillez contacter votre
centre de service local. (Reportez-vous
au chapitre Centre d'information a la
clientele.)

* Ne soumettez pas le moniteur a de
fortes vibrations ou a des impacts violents
lorsque vous l'utilisez.

* Ne pas heurter ni laisser tomber le
moniteur pendant I'utilisation ou le
transport.

Entretien

* Afin de protéger votre moniteur contre
des dommages, n'appuyez pas trop
fortement sur I'écran LCD. Lorsque vous
déplacez le moniteur, saisissez-le par son
cadre pour le soulever ; ne mettez pas vos
mains ni vos doigts sur I'écran LCD pour
le soulever.

» Débranchez le moniteur si vous envisagez
de ne pas l'utiliser pendant un certain
temps.

* Débranchez le moniteur si vous voulez
le nettoyer. Pour ce faire, utilisez un
chiffon Iégérement humide. Vous pouvez
aussi vous servir d'un chiffon sec, pour
autant que le moniteur soit hors tension.
Par contre, n'utilisez jamais de solvants
organiques, tels que l'alcool ou des liquides
a base d'ammoniaque, pour nettoyer le
moniteur.

* Afin d'éviter tout risque d'électrocution ou
d'endommagement permanent a |'appareil,
n'exposez pas le moniteur a la poussiere ni
a la pluie.



* Ne le mettez pas non plus en contact
avec de I'eau ni avec un environnement
excessivement humide.

* Sivotre moniteur est mouillé par de I'eau,
essuyez-le aussi rapidement que possible a
I'aide d'un chiffon sec. Si un corps étranger
ou de |'eau pénétrent dans le moniteur,
mettez-le immédiatement hors tension
et débranchez le cordon secteur. Retirez
ensuite le corps étranger ou épongez
I'eau et envoyez le moniteur au centre de
maintenance.

* Ne pas stocker ni utiliser le moniteur dans
des endroits tels qu'il risque d'étre exposé
a de la chaleur, a la lumiére directe du soleil
ou a un froid extréme.

*  Afin d'assurer les performances optimales
de votre moniteur et I'utiliser pendant
plus longtemps, il doit se trouver dans
un endroit compris dans les plages de
température et d'humidité suivantes :

* Température : 0-40°C 32-95°F
*  Humidité : 20-80% HR

Informations importantes pour les images
rémanentes/fantdmes

* Activez systématiquement un programme
économiseur d'écran en mouvement
lorsque votre écran n'est pas sollicité.
Activez systématiquement une application
de rafraichissement périodique de votre
moniteur pour afficher un contenu
statique fixe. L'affichage sans interruption
d'image statique ou immobile sur une
longue période peut engendrer une «
rémanence a 'extinction », également
appelée « image résiduelle » ou « image
fantéme » sur votre écran.

* Lesimages « rémanentes », « en
surimpression » ou « fantdmes » sont un
phénomene bien connu de la technologie
des dalles de moniteurs. Dans la plupart
des cas, cette « rémanence a I'extinction
», ou « image résiduelle » ou « image
fantdme » disparalt progressivement une
fois l'alimentation éteinte.

) Avertissement

Le fait de ne pas activer d'économiseur d'écran
ni d'application de rafraichissement périodique
de I'écran peut conduire a des symptémes de
« rémanence a 'extinction », ou d' « image
résiduelle » ou d' « image fantdme » les plus
graves, qui ne disparaissent pas et ne peuvent
pas étre réparés. Ce dommage n'est pas
couvert par votre garantie.

Service aprés-vente :

* Le bofltier peut uniquement étre ouvert
par un technicien qualifié.

* Sivous avez besoin de documents en
vue d'une réparation, veuillez prendre
contact avec votre centre de service local.
(Reportez-vous au chapitre « Centre
d'information a la clientéle. »)

*  Pour plus d'informations sur le transport,
veuillez vous référer a la section
« Caractéristiques techniques ».

* Ne laissez pas votre moniteur dans une
voiture ni dans un coffre de voiture a la
lumiere directe du soleil.

© Remarque

Adressez-vous a un technicien si le moniteur ne
fonctionne pas normalement ou si vous n'étes
pas sUr(e) de la procédure a suivre apres avoir
lu les instructions du mode d'emploi.



1.2 Notations

Les sous-parties suivantes décrivent les
différentes conventions de notation utilisées
dans ce document.

Notes, mises en garde et avertissements
Tout au long de ce guide, des blocs de texte
pourront étre accompagnés d'une icone et
imprimés en caracteres gras ou en italiques.
Ces blocs contiennent des notes, des mises en
garde ou des avertissements. lls sont utilisés de
la facon suivante:

€ Remarque

Cette icbne indique I'existence d'informations
et de conseils importants vous aidant a mieux
utiliser votre ordinateur:

@ Mise en garde

Cette icbne indique I'existence d'informations
vous expliguant comment éviter
I'endommagement potentiel de votre matériel
ou la perte de données.

) Avertissement

Cette icbne indique qu'il existe un risque de
blessures et vous explique comment éviter le
probléme.

Il se peut que des avertissements apparaissent
sous des formats différents et ne soient pas
accompagnés d'icdnes. Dans ces cas-1, la
présentation spécifique de |'avertissement

est dictée par les autorités chargées des
réglementations.

1.3 Mise au rebut du produit et des
matériaux d’emballage

Déchet d'équipement électrique et
électronique - DEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers
Your display is manufactured with high quality

materials and components which can be
recycled and reused.

To learn more about our recycling program

please visit www.philips.com/about/sustainability/
recycling.


http://www.philips.com/about/sustainability/recycling
http://www.philips.com/about/sustainability/recycling
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2. Installation du moniteur B Installation

1. Placez le moniteur, face vers le bas, sur une
surface douce. Faites attention a ne pas
rayer ni endommager I'écran.

2.1 Installation

El Contenu de la boite

Quick E

Start

PHILIPS

2. Maintenez le moniteur et le socle avec vos
deux mains. Pliez doucement le socle vers
le bas selon I'angle voulu.

VGA (optionnel) HDMI (optionnel) DVI (optionnel)

€ Remarque
Utilisez uniqguement le modele d'adaptateur
CA/CC fourni : Philips ADPC1245

3. Pour retenir le moniteur, pliez la base
verticalement vers le haut.




El Connexion a votre PC

Modeéle 239C4QH :

@ Entrée d'alimentation CA/CC

© Entrée VGA

© Entrées HDMI (HDMI1 et HDMIR)
O Sortie audio HDMI

O Verrou antivol Kensington

Modele 239C4Q :

PHILIPS

@ Entrée d'alimentation CA/CC
© Entrée VGA

© Entrée DV

© Verrou antivol Kensington

Connexion a un PC

1.

-+

Mettez votre ordinateur hors tension et
débranchez son cable d'alimentation.

Branchez le cable VGA ou DVI pour la
connexion vidéo.

Branchez I'entrée d'alimentation CC sur
votre moniteur.

Branchez le cordon d'alimentation de
I'adaptateur CA/CC sur une prise CA a
proximité.

Mettez votre ordinateur et le moniteur
sous tension. Si le moniteur affiche une
image, cela signifie que I'installation est
terminée.



2.2 Utilisation du moniteur

El Description des boutons de commande

N

/v ©/a 0) /4 /0K

I I | [\ I

(7] (6] (4] ® 0 (1]
Ouvre le menu OSD.

0 S/0K Confirme le réglage de I'OSD.
Retourne au niveau précédent

o < du menu OSD.

© | 8 |Utilisez la fonction Turbo.
Allume et éteint (MARCHE et

(4] @  |ARRET) I'alimentation du moni-
teur.

© | AV Ajuste le menu OSD.
Change la source d'entrée du

6 © signal.
touche de raccourci Smartlmage.
Vous pouvez choisir entre 7

Q@ @ modes différents : Text (Texte),
Office (Bureau), Photo, Movie
(Film), Game (Jeux), Economy
(Economie), Off (Arrét).

E1 Description de I'affichage sur écran
Qu’est-ce que Affichage a I'écran (OSD)?

La fonction d'affichage des menus a I'écran
(OSD) est présente avec tous les moniteurs
LCD de Philips. Elle permet a I'utilisateur

final d'effectuer des réglages d'écran ou de
sélectionner directement les fonctions du
moniteur par le biais d'une fenétre d'instructions
apparaissant a I'écran. Une interface conviviale,
semblable a celle reproduite ci-apres, apparait :

Modéle 239C4QH :

VGA
<= Input
HDMI1

HDMI2
[ picur

Instructions simples et basiques sur les
touches de contréle

Dans le menu OSD ci-dessus, 'utilisateur peut
appuyer sur les boutons ¥ A situées sur le
panneau frontal du moniteur pour déplacer le
curseur, et sur OK pour confirmer un choix ou
une modification.



Le menu OSD

Vous trouverez ci-dessous une vue d'ensemble
de la structure de l'affichage sur écran.Vous
pourrez par la suite I'utiliser comme référence
lorsque vous voudrez plus tard revenir aux
différents réglages.

Main menu Sub menu
— Input — VGA
— DVI (optional)
— HDMI1 (optional)
— HDMI2 (optional)
— Picture — Picture Format — Wide Screen, 4:3
— Brightness — 0~100
r— Contrast — 0~100
— SmartKolor — On, Off
— SmartTxt — On, Off
— SmartResponse —— Off, Fast, Faster, Fastest
— SmartContrast — On, Off
— Gamma — 18,20,22,24,26
— Pixel Orbiting — On, Off
L— Over Scan — On, Off
— Audio Volume — 0~100
(optional) [
Mute — On, Off
— Color Color Temperature — 5000K, 6500K, 7500K,
E 8200K, 9300K, 11500K
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100
— Language — English . Espafiol, Frangais, Deutsch, Italiano,
Portugués, Pycckui, 8] fxH13C
[ OSD Settings  — Horizontal — 0~100
— Vertical — 0~100
|— Transparency — Off.1,2,3,4
— OSD Time Out — 55, 10s, 20s, 30s, 60s
—— Setup — Auto
— H.Position — 0~100
— V.Position — 0~100
— Phase — 0~100
[— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes,No
L Information

El Avis de résolution

Ce moniteur a été congu pour fonctionner de
maniere optimale a sa résolution native, qui est
1920 x 1080 @ 60 Hz. Quand le moniteur est
allumé a une autre résolution, le message d'alerte
suivant s'affiche a 'écran : Use 1920 x 1080

@ 60 Hz for best results (Utilisez la résolution
1920 x 1080 @ 60 Hz. pour des résultats
optimaux.)

L'affichage du message d'alerte de résolution
native peut étre désactivé a partir de
Configuration dans le menu d'affichage a I'écran
(OSD).

B Fonction physique

Inclinaison




3. Optimisation de l'image

3.1 Smartlmage

El De quoi s'agit-il?

Smartlmage propose des préréglages qui vous
permettent d'optimiser I'affichage de différents
types de contenu en ajustant dynamiquement la
luminosité, le contraste, la couleur et la netteté
en temps réel. Qu'il s'agisse de travaux sur des
applications de texte, d'affichage d'images ou

de visualisation d'un clip vidéo, Smartlmage

de Philips vous propose un moniteur avec des
performances optimisées.

E1 Pourquoi en ai-je besoin?

Vous attendez de votre moniteur un affichage
optimisé de tous vos types favoris de contenu.
Le logiciel Smartimage ajuste dynamiquement
la luminosité, le contraste, la couleur et la
netteté en temps réel pour une expérience de
visionnage améliorée avec votre moniteur.

El Comment ¢a marche?

Smartlmage est une technologie Philips exclusive
et de pointe. Elle analyse le contenu affiché

sur votre écran. En se basant sur un scénario
choisi, Smartlmage optimise dynamiquement

le contraste, la saturation des couleurs et la
netteté des images pour des performances
d'affichage ultimes, le tout en temps réel par la
simple pression sur un bouton.

Bl Comment activer Smartlmage ?

= @) —

1. Appuyez sur &» pour lancer Smartlmage
sur l'affichage a I'écran.

2. Restez appuyé sur ep pour passer d'une
fonction a une autre, Text (Texte), Office
(Bureau), Photo, Movie (Film), Game (Jeux),
Economy (Economie) et Off (Arrét).

3. L'affichage Smartlmage sur I'écran reste

affiché pendant 5 secondes, ou vous
pouvez également appuyer sur "OK" pour
confirmer.

4. Une fois Smartlmage activé, le schéma
sRVB est automatiquement désactivé. Pour
utiliser le modele sRVB, il faut désactiver
Smartimage en utilisant le bouton @D sur
le panneau avant de votre moniteur.

Outre I'utilisation de la touche B pour le
défilement vers le bas, vous pouvez également
appuyer sur les boutons w A pour effectuer
votre choix, puis sur « OK » pour confirmer
la sélection et fermer le menu a I'écran
Smartimage.

Vous pouvez choisir entre sept modes
différents :Text (Texte), Office (Bureau), Photo,
Movie (Film), Game (Jeux), Economy (Economie)
et Off (Arrét).

@ SmartImage

Text

Office
Photo
Movie

Game

Economy

*  Text (Texte) : Aide a améliorer la lecture
des applications de texte telles que les
livres électroniques en PDF. En utilisant
un algorithme spécial qui augmente le
contraste et la netteté du contour du texte,
I'affichage est optimisé pour une lecture
sans stress en ajustant la luminosité, le
contraste et la température de couleur de
I'écran.

*  Office (Bureau) : Optimise le texte et
adoucit la luminosité pour augmenter la
lisibilité et réduire la fatigue oculaire. Ce
mode optimise la lisibilité et la productivité
de facon significative lorsque vous travaillez
avec des feuilles de calcul, des fichiers PDF,
des documents numérisés et d'autres
applications générales de bureau.



*  Photo : Ce profil associe la saturation
des couleurs, le contraste dynamique
et 'optimisation de la netteté pour un
affichage de photos et d'autres images
incroyablement clair avec des couleurs vives
- le tout sans effet parasite et sans couleurs
estompées.

*  Movie (Film) : La luminance accentuée,
la saturation profonde des couleurs, le
contraste dynamique et la netteté précise
permettent d'obtenir un affichage de
chaque détail dans les zones sombres de
vos clips vidéo, sans décoloration dans les
zones plus lumineuses, tout en maintenant
des valeurs dynamiques naturelles pour un
affichage vidéo optimal.

*  Game (Jeux) : Activez le circuit ‘overdrive’
pour obtenir un meilleur temps de
réponse, moins de flou sur les bords avec
des images qui changent rapidement sur
I'écran, un meilleur taux de contraste pour
les scénes claires ou foncées ; ce profil est
idéal pour les jeux.

+  Economy (Economie) : Dans ce
profil, le réglage de la luminosité et du
contraste ainsi que la rectification fine du
rétroéclairage permettent d'obtenir un
affichage correct pour les applications
quotidiennes de bureau, tout en diminuant
la consommation électrique.

e Off (Désactivé) : Pas d'optimisation par
Smartlmage.

3.2 SmartKolor

El De quoi s'agit-il?

SmartKolor est une technologie spéciale
d'extension des couleurs qui est en mesure
d'améliorer la gamme de couleurs pour offrir
des performances visuelles d'images éclatantes
et riches.

E1 Pourquoi en ai-je besoin?

Vous voulez des images riches et dynamiques
pour vivre des photos ou des vidéos
remarquables.

E Comment ¢a marche?

SmartKolor améliore dynamiquement la
saturation des couleurs et étend la gamme de
couleurs pour enrichir la qualité visuelle des
couleurs et les performances de visualisation
de vos images. SmartKolor se désactive
automatiquement, par exemple, en mode
Texte ou en mode Bureau, quand il n'est pas
nécessaire.

3.3 SmartContrast

El De quoi s'agit-il?

Cette technologie unique analyse de fagon
dynamique le contenu a I'écran, et optimise
automatiquement le contraste du moniteur
pour une clarté visuelle et un plaisir visuel
maximum. Le rétroéclairage est ainsi augmenté
pour des images plus claires, plus précises et
plus lumineuses, ou diminué pour un affichage
clair des images sur fond sombre.

E1 Pourquoi en ai-je besoin?

Vous attendez une clarté visuelle optimale

et un confort visuel, quel que soit le type de
contenu a I'écran. SmartConstrast contréle
dynamiquement le contraste et ajuste le
rétroéclairage pour des images ou des

écrans de jeu et de vidéo claires, précises et
lumineuses, et pour du texte de bureautique
lisible. En réduisant la consommation électrique
de votre moniteur, vous réalisez des économies
énergétiques et prolongez la durée de vie de
votre écran.

E Comment ¢a marche?

Lorsque vous activez SmartContrast, ce dernier
va analyser le contenu affiché en temps réel

et ajuster les couleurs et contréler l'intensité

du rétroéclairage. Cette fonction permet
d'optimiser dynamiquement le contraste

pour plus de plaisir dans votre divertissement,
visionnage de clips vidéo ou jeux.



3.4 SmartSharpness

El De quoi s'agit-il?

La technologie Smart renforce la netteté
lorsque vous en avez besoin pour des
performances d'affichage optimales et plus
de divertissement lors que vous regardez des
vidéos ou des photos.

E1 Pourquoi en ai-je besoin?

Vous voulez le summum en termes de netteté
pour plus de plaisir lorsque vous visionnez des
photos ou des vidéos.

E Comment ¢ca marche?

La technologie Smart renforce la netteté
lorsque vous en avez besoin pour des
performances d'affichage optimales et plus

de divertissement lors que vous regardez des
vidéos ou des photos en mode Film ou un Jeux.
Il est désactivé pour avoir un affichage de qualité
supérieure des applications de bureautique

et en mode Fconomie pour réduire la
consommation d'énergie.

3.5 Philips SmartControl Premium

Le nouveau logiciel SmartControl Premium

de Phillips vous permet de contrdler votre
moniteur a I'aide d'une interface graphique facile
a utiliser. C'en est fini des réglages compliqués,
ce logiciel pratique vous aide a ajuster la
résolution, a faire |'étalonnage des couleurs, les
réglages de I'horloge/de la phase, le réglage du
point blanc RGB, etc.

Grace aux derniéres technologies dans
I'algorithme principal, offrant un traitement et
un temps de réponse plus rapides, ce logiciel
compatible avec Windows 7 est basé sur des
icones avec une interface trés conviviale pour
vous aider a bien utiliser vos moniteurs de
Philips.

El Installation

* Suivez les instructions pour l'installation.

* Vous pouvez le lancer une fois I'installation
terminée.

*  Sivous voulez lancer le logiciel
ultérieurement, vous pourrez alors cliquer
sur le raccourci du bureau ou de la barre
d'outils.

PHILIPS

Premier lancement — Assistant

* La premiere fois apres l'installation de
SmartControl Premium, l'assistant est
automatiquement lancé.

* L'assistant va vous aider a ajuster les
performances de votre moniteur, étape
apres étape.

* Rendez-vous dans le menu Plug-in
(Branchement) pour lancer l'assistant
ultérieurement.

Vous pouvez ajuster davantage d'options

sans |'assistant depuis le panneau Standard.
Tx

SmartControl "remism PHILIPS

Wizard




E3 Lancement depuis le panneau Standard:

Menu Adjust (Réglage)

Le menu Adjust (Réglage) vous permet
d'ajuster la Brightness (luminosité), le
Contrast (contraste) et la Resolution
(résolution).

Suivez les instructions pour effectuer les
réglages.
Linvite Cancel (Annuler) vous permet
d'annuler l'installation.
e 2x
SmartContrg| Premivm PHILIPS
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SmartControl| Premivm
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Menu Color (Couleur)

Le menu Color (Couleur) vous permet
d'ajuster le rouge/vert/bleu, le Black Level
(niveau de noir), le White Point (point
blanc), le Display Gamma (gamma de
I'affichage), la Calibration (étalonnage des
couleurs), Smartlmage et SmartKolor.

Suivez les instructions pour effectuer les
réglages.

Référez-vous au tableau ci-dessous pour
les éléments du sous-menu selon votre
choix.

Exemple pour la Color Calibration
(étalonnage des couleurs).

——T—— i

SmartContro| Premivm PHILIPS

RGH

advm




P—r— ix T — ix
SmartContro| Premivm PHILIPS SmartContro| Premivm PHILIPS

Hlack Level Calibration

advm !

I
R o

i s o Power

S e var

§ Qg B oﬁ 8
L

T s 1

« Show Me » lance le tutoriel d'aide a
SmartControl Fremivm PHILIPS I'étalonnage des couleurs.

2. Start (Démarrer) - lance la séquence
d'étalonnage des couleurs en 6 étapes.

3. Quick View (Visualisation rapide) charge les
images précédente/suivante.

4. Pour retourner au panneau d'accueil Color
(Couleur), cliquez sur le bouton Cancel
(Annuler).

5. Enable Color Calibration (Active
I'étalonnage des couleurs) - activé par
défaut. Si la case n'est pas cochée, il n'y a
pas d'étalonnage des couleurs, les boutons
Démarrer et Visualisation rapide sont grisés.

it v T 6

Les informations relatives au brevet doivent

Premium 4 4
SmartControl PHINPS figurer sur I'écran d'étalonnage.

Ecran de premier Color Calibration
(étalonnage des couleurs)

&g B aﬁ £

* Le bouton Previous (précédent) est
désactivé jusqu'au deuxiéme écran de
couleur.
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*  Next (Suivant) permet d'accéder a la cible
suivante (6 cibles).

* Enfin allez dans le panneau File>Presets
(Fichier>Préréglages).

» Cancel (Annuler) ferme l'interface
utilisateur et retourne a la page
Branchement.

Smartlmage

Permet a I'utilisateur de modifier les réglages
pour un meilleur affichage selon le contenu.

Lorsque le mode Entertainment
(Divertissement) est activé, SmartContrast et

SmartResponse sont également activés.
1x
SmartContro| Premium PHILIPS

Smart Innage

Aafpt !u
i

~ 3
- -

i1 z0

g
is
553 iri3%

Menu de ECO Power (alimentation ECO)
P ———— ix
Premium

SmartControl PHILIPS

Power Savings
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Menu Options

Options>Preferences (Préférences) - n'est
disponible que lorsque vous choisissez
Preferences (Préférences) dans le menu
déroulant Options. Sur un écran non pris en
charge, mais compatible DDC/CI, seuls les
onglets Help (Aide) et Options sont disponibles.

PHILIPS

SmartControl Premivm

&

Preferences

2.

-

\ﬂ P ‘

e e

* Affiche les réglages préférés actuels.
* Cochez la case pour activer la fonction. La
case a cocher est une touche a bascule.

* Enable Context Menu (Activer le menu
contextuel) sur le bureau est coché
(activé) par défaut. Enable Context Menu
(Activer le menu contextuel) affiche les
sélections SmartControl Premium pour
Select Preset (Choisir préréglage) et Tune
Display (Régler affichage) dans le menu
contextuel du bureau (clic avec le bouton
droit). Désactivé supprime SmartControl
Premium du menu contextuel (clic avec le
bouton droit).

* Licone Enable Task Tray (Activer barre
des taches) est coché (activé) par défaut.
Activer le menu contextuel affiche
le menu de la barre des taches pour
SmartControl Premium. Cliquez avec le
bouton droit sur I'icéne de la barre des
taches pour afficher les options du menu
pour Help (Aide), Technical Support
(Assistance technique), Check for Update
(Controler les mises a jour), About (A



propos) et Exit (Quitter). Lorsque le

menu Enable Task Tray (Activer barre des

taches) est désactivé, I'icone de la barre
des taches n'affiche que Exit (Quitter).

Run at Start (Exécution au démarrage)
est coché (activé) par défaut. En cas de
désactivation, SmartControl Premium
n'est pas lancé au démarrage ou reste
dans la barre des taches. Pour lancer
SmartControl Premium, utilisez le
raccourci depuis le bureau ou la liste des
programmes. Si cette case est décochée
(désactivée), aucun préréglage ne se
charge au démarrage, méme s'il a été
défini comme devant s'exécuter au
démarrage.

Activer le Mode transparence (Windows
7, Vista, XP). Par défaut : 0% opaque.

Options>Audio - n'est disponible que lorsque
vous choisissez Volume dans le menu déroulant

Options.

Sur un écran non pris en charge, mais
compatible DDC/C], seuls les onglets Help
(Aide) et Options sont disponibles.

Tx

SmartContro| "remim PHILIPS
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Option>Auto Pivot (Pivot automatique)

T Tx

SmartContro| "remim PHILIPS

Autn Pheot
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Options>Input (Entrée) - n'est disponible que
lorsque vous choisissez Input (Entrée) dans le
menu déroulant Options. Sur un écran non pris
en charge, mais compatible DDC/CI, seuls les
onglets Help (Aide) et Options sont disponibles.
Aucun autre onglet de SmartControl Premium
n'est disponible.

T Tx

SmartContro| "remim PHILIPS
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* Affiche le panneau d'instructions Source
et le paramétrage actuel de la source
d'entrée.

* En mode affichage d'entrée simple, ce
panneau n'est pas visible.



Options>Theft Deterrence (Antivol) - Le
panneau Theft Deterrence (Antivol) n'est
disponible que lorsque vous choisissez le mode
Theft Deterrence (Antivol) dans le menu
déroulant Plug-in (Greffons).

re— T ax

SmartContro| "remim PHILIPS

Thelt Deterrence

o e

Pour activer le systeme Theft Deterrence
(Antivol), cliquez sur le bouton On (Activer)
afin d'afficher le menu suivant :

e Saisissez un PIN de 4 a 9 chiffres
seulement.

* Une fois le PIN saisi, le fait d'appuyer sur
le bouton Accept (Accepter) affiche une
bofte de dialogue sur la page suivante.

* Minutes minimum réglé sur 5. Le curseur
est réglé sur 5 par défaut.

* Inutile d'attacher I'écran a un autre
dispositif pour entrer en mode Theft
Deterrence (Antivol).

Apres la création du PIN, le panneau Systéme

Theft Deterrence (Antivol) indique Systéme

Theft Deterrence (Antivol) activé et affiche le

bouton PIN Options (Options PIN):

*  Systeme Theft Deterrence activé (Antivol
activé) saffiche.

e Désactiver le Mode Theft Deterrence

(Antivol) ouvre I'écran de la page suivante.

* Le bouton PIN Options (Options PIN)

n'est disponible qu'aprés avoir crée le PIN.

Ce bouton permet d'accéder au site Web
de PIN sécurisé.

Menu Help (Aide)

Help>User Manual (Aide>Manuel d'utilisation)
- n'est disponible que lorsque vous choisissez
User Manual (Manuel d'utilisation) dans le menu
déroulant Help (Aide). Sur un écran non pris
en charge, mais compatible DDC/CI, seuls les
onglets Help (Aide) et Options sont disponibles.

e ==
SmartContro| Premivm PHILIPS

User Manal

« Toch. Sepport
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Help (Aide)>Version - n'est disponible que
lorsque vous choisissez Version dans le menu
déroulant Help (Aide). Sur un écran non pris

en charge, mais compatible DDC/CI, seuls les
onglets Help (Aide) et Options sont disponibles.

e e
SmartContro| Premivm PHILIPS

Version



Context Sensitive menu (Menu sensible au
contexte)

Le Context Sensitive menu (menu sensible

au contexte) est Activé par défaut. Si Enable
Context Menu (Activer le menu contextuel) est
coché dans le panneau Options>Preferences
(Préférences), le menu est alors visible.

E] SmartControf Fremsm
Select Presst L4
Tune Display

Power Saver 4

Odffice
Photo
Movie
Text
Gramme

Economy

Le Context Menu (menu contextuel) présente
quatre entrées :

¢ SmartControl Premium - si sélectionné,
I'écran About (A propos) s'affiche.

» Select Preset (Choisir préréglage) -
présente un menu hiérarchique des
préréglages enregistrés pour une
utilisation immédiate. La marque « coché
» indique le préréglage actuellement
sélectionné. Il est également possible de
choisir le Factory Preset (Préréglage usine)
depuis le menu déroulant.

* Tune Display (Régler affichage) - ouvre
le panneau de commande SmartControl
Premium.

* Smartlmage — Vérifie les réglages
existants: Off (Arrét), Office (Bureau),
Photo, Movie (Film), Text (Texte), Game
(Jeux) et Economy (Economie).

Menu Barre des taches activé

Le menu barre des taches s'affiche en cliquant
avec le bouton droit sur I'icéne SmartControl
Premium, depuis la barre des taches. Cliquez
avec le bouton gauche pour lancer |'application.

Find Windows k
Desktop Partition  *
Identify Partition
Align On

Help

Techniral Support

Check for Update
Ahont

I Exit g

La barre des taches présente cinqg entrées :

* Help (Aide) - acces au fichier du User
Manual (manuel d'utilisation) : Ouvre
le fichier du User Manual (manuel
d'utilisation) en utilisant la fenétre du
navigateur par défaut.

» Technical Support (Assistance technique)
- affiche la page de I'assistance technique.

*  Check for Update (Contréler les mises
a jour) - acces a la page de renvoi PDI
et contrdle la version de I'utilisateur par
rapport a la derniere version disponible.

+  About (A propos) - affiche les
informations détaillées de référence :
version du produit, informations sur la
publication et nom du produit.

» Exit (Quitter) - Ferme SmartControl
Premium.



Pour exécuter SmartControl Premium une
nouvelle fois, sélectionnez SmartControl

Premium dans le menu Program (Programmes),

double-cliquez sur 'icéne PC de bureau ou
redémarrez le systeme.

PHILIPS

SmartControl Premium

Menu Barre des tiches désactivé

Lorsque la Barre des taches est désactivée
dans le dossier des préférences, seul le

choix Exit (Quitter) est disponible. Pour
supprimer complétement SmartControl
Premium de la barre des taches, désactivez
Run at Startup (Exécuter au démarrage) sous
Options>Preferences (Préférences).

© Remarque

Toutes les illustrations de cette section sont
données a titre de référence uniquement. La
version du logiciel SmartControl peut étre
modifiée dans préavis.Veuillez toujours vérifier
le site Web officiel Portrait www.portrait.
com/dtune/phl/enu/index pour télécharger la
derniére version du logiciel SmartControl.
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3.6 Guide SmartDesktop

El SmartDesktop

SmartDesktop est dans SmartControl Premium.
Installez SmartControl Premium et choisissez
SmartDesktop dans les Options.

P T

SmartControl Fremivm PHILIPS
| SmartDesktop
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* La case a cocher Align to partition (Aligner
sur la partition) permet l'alignement
automatique de la fenétre lorsqu'elle est
glissée dans la partition définie.

* Sélectionnez la partition souhaitée en
cliquant sur l'icéne. La partition sera
appliquée sur le bureau et I'icone sera en
surbrillance.

* |dentify (Identifier) offre un moyen rapide
pour afficher la grille.

22 2D
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Bl Glisser-et déposer des fenétres

Une fois les partitions configurés et Align to
partition (Aligner sur la partition) sélectionnée,
une fenétre peut étre glissée dans la zone et
elle sera automatiquement alignée. Lorsque la


www.portrait.com/dtune/phl/enu/index
www.portrait.com/dtune/phl/enu/index

fenétre et le curseur de la souris sont dans la
zone, la zone passe en surbrillance.

© Remarque

Si le contour de la zone n'est pas visible lorsque
vous faites glisser la fenétre, « Show windows
contents while dragging » (Afficher le contenu
des fenétres pendant leur déplacement) est
désactivé. Pour activer :

1. Dans le Control Panel (Panneau de
configuration), cliquez sur System
(Systeme).

2. Cliquez sur Advanced system settings
(Parameétres systéme avancés) (pour Vista
& Win7 OS, il se trouve dans le volet de
gauche)

3. Dans la section Performance
(Performances), cliquez sur Settings
(Paramétres).

4. Dans la bofte, cochez Show window
contents while dragging (Afficher le
contenu des fenétres pendant leur
déplacement), et cliquez sur OK.

Autre chemin alternatif :

Vista :

« Control Panel » (Panneau de configuration)
> « Personalization » (Personnalisation) > «
Window Color and Appearance » (Couleur et
apparence des fenétres) > Cliquez sur « Open
Classic appearance properties for more color
options » (Ouvrir les propriétés d'apparence
classique pour des options de couleurs
supplémentaires) > Cliquez sur le bouton «
Effects » (Effets) > cochez « Show window
contents while dragging » (Afficher le contenu
des fenétres pendant leur déplacement)

XP:

«Display Properties» (Propriétés d'affichage)
> «Appearance» (Apparence) > «Effects..»
(Effets...) > cochez « Show window contents
while dragging » (Afficher le contenu des
fenétres pendant leur déplacement)
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Win7:

Aucun autre chemin alternatif disponible.

El Options de la barre de titre

Desktop Partition (Partition du bureau) est
accessible a partir de la barre de titre de la
fenétre active. Cela fournit un moyen rapide

et facile de gérer le bureau ainsi que d'envoyer
une fenétre quelconque vers une partition sans
avoir a glisser-déposer. Déplacez le curseur dans
la barre titre de la fenétre active pour accéder
au menu déroulant.

1 Menu de clic-droit

Cliquez-droit sur I'icéne Desktop Partition
(Partition du bureau) pour afficher le menu
déroulant.

Find Windows 3
Desktop Partition  #
Identify Partition

Align Off

1. Find Windows (Trouver les fenétres)
— Dans certains cas, I'utilisateur peut
avoir envoyé plusieurs fenétres vers la
méme partition. Find Window (Trouver
les fenétres) affiche toutes les fenétres
ouvertes et déplace la fenétre sélectionnée
au premier plan.

2. Desktop Partition (Partition du bureau)
— Desktop Partition (Partition du
bureau) affiche la partition actuellement
sélectionnée et permet a I'utilisateur
de basculer rapidement vers |'une
des partitions présentées dans la liste
déroulante.
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SmartControl Premum

© Remarque

Si plus d'un affichage est connecté, I'utilisateur
peut choisir |'affichage ciblé pour changer la
partition. L'icéne en surbrillance représente la
partition active actuelle.

3. ldentify Partition (Identifier la partition) —
Affiche la grille contour sur le bureau pour
la partition actuelle.

4. Align On/Align Off (Aligner activé/Aligner
désactivé) — Active/désactive la fonction
d'alignement automatique par glisser-
déplacer.

5. Exit (Quitter) — Ferme Desktop Partition
(Partition du bureau) et Display Tune
(Régler I'affichage). Pour réinitialiser; lancer
Display Tune (Régler I'affichage) depuis
le menu Démarrer ou le raccourci sur le
bureau.

H Menu de clic-gauche

Cliguez-gauche sur l'icdne Desktop Partition
(Partition du bureau) pour envoyer rapidement
la fenétre active vers une partition quelconque
sans avoir a glisser-déplacer. Relachez la souris
pour envoyer la fenétre vers la partition en
surbrillance.

A Clic-droit sur la barre des taches

La barre des tiches contient également la
plupart des fonctionnalités prises en charge
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dans la barre de titre (a I'exception de I'envoi
automatique d'une fenétre vers une partition).

Tdentify Partition
Align Off

Bright Light

Dim Light

Help

Technical Support
Chack for Update
About

Exit

*  Find Windows (Trouver les fenétres)
— Dans certains cas, I'utilisateur peut
avoir envoyé plusieurs fenétres vers
la méme partition. Find Windows
(Trouver les fenétres) affiche toutes les
fenétres ouvertes et déplace la fenétre
sélectionnée au premier plan.

* Desktop Partition (Partition du
bureau) — Desktop Partition (Partition du
bureau) affiche la partition actuellement
sélectionnée et permet a |'utilisateur
de basculer rapidement vers I'une
des partitions présentées dans la liste
déroulante.

* Identify Partition (Identifier la partition)
— Affiche la grille contour sur le bureau
pour la partition actuelle.

» Align On/Align Off (Aligner activé/Aligner
désactivé) — Active/désactive la fonction
d'alignement automatique par glisser-
déplacer.



Définitions des partitions de SmartDesktop

Nom

Full Desktop (Bureau
complet)

Description

Applique tous les paramétres a |'ensemble du bureau.

Vertical Evalue la résolution de I'écran et divise I'affichage en deux
zones verticales de taille égale.
Pour maintenir la configuration verticale 90/270.
Horizontal Evalue la résolution de I'écran et divise I'affichage en deux

zones horizontales de taille égale.

Pour maintenir la configuration horizontale 90/270.

Vertical Triple (Triple
vertical)

Evalue la résolution de I'écran et divise |'affichage en trois
zones verticales de taille égale.

Pour 90 Partition 1 horizontal haut Partition 2 horizontal
centre Partition 3 horizontal bas.

Pour 270 Partition 3 horizontal haut Partition 2 horizontal
centre Partition 1 horizontal bas.

Vertical Split Left (Ver-
tical fractionné gauche)

Evalue la résolution d'écran et divise I'affichage en deux
zones verticales, le coté gauche est une seule zone, le
c6té droit est divisé en deux zones de taille égale

Pour 90 Partition 1 en haut Partitions 2&3 en bas.

Pour 270 Partition 1 en bas Partitions 2&3 en haut.

Vertical Split Right
(Vertical fractionné
droite)

Evalue la résolution d'écran et divise l'affichage en deux
zones verticales, le coté droit est une seule zone, le c6té
gauche est divisé en deux zones de taille égale

Pour 90 Partitions 1&2 en haut Partition 3 en bas.

Pour 270 Partition 3 en haut Partitions 1&2 en bas.
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Nom

Horizontal Split Top
(Horizontal fractionné
haut)

Description

Evalue la résolution d'écran et divise I'affichage en deux
zones horizontales de taille uniforme, la zone supérieure
est unique, la zone inférieure est divisée en deux zones

de taille égale

For 90 Partition 1 sur le c6té droit Vertical Partitions 2&3
sur le c6té gauche Vertical.

For 270 Partition 1 sur le c6té gauche Vertical Partitions
283 sur le coté droit Vertical.

Horizontal Split
Bottom (Horizontal
fractionné bas)

Evalue la résolution d'écran et divise I'affichage en deux
zones horizontales de taille uniforme, la zone inférieure

est unique, la zone supérieure est divisée en deux zones
de taille égale

For 90 Partitions 1&2 sur le coté droit Vertical Partition 3
sur le c6té gauche Vertical.

For 270 Partitions 1&2 sur le coté gauche Vertical Parti-
tion 3 sur le c6té droit Vertical.

Even Split (Fractionne-
ment égal)

Evalue la résolution de I'écran et divise I'affichage en
quatre zones de taille égale.

21




4. Caractéristiques techniques

vertical

Type de dalle d'écran LCD-IPS
Rétroéclairage DEL

Taille de la dalle 23" L (58,42cm)
Proportions 169

Taille de pixel 0,265 x 0,265 mm
Luminosité 250 cd/m?
SmartContrast 20,000,000:1

Taux de contraste (typique) 1000:1

Temps de réponse (typique) 14 ms

Temps SmartResponse (typ.) 5ms

Résolution optimale 1920 x 1080 @ 60Hz
Angle de vue 178° (H) / 178° (V) @ Tx Contraste > 10
Couleurs d'affichage 16,7 M

Fréquence de rafraichissement 56 Hz - 76 Hz

Fréquence horizontale

30 kHz - 83 kHz

sRGB

Entrée de signal

Oul

239C4QH: HDMIM, HDMI2 (numérique), VGA (analogique)
239C4Q: DVI (Numérique), VGA (Analogique)

Signal d'entrée

Fonctions pratiques

Synchro séparée, synchro sur vert

/v ©/A ) /4 =/0K

Langues OSD

Anglais, Francais, Allemand, Espagnol, Italien, Russe,
Chinois simplifié, Portugais

Autres fonctions pratiques

Verrouillage Kensington

Compatibilité Plug & Play

Inclinaison

DDC/CI, sRGB, Windows 7/Vista/XP Mac OSX, Linux

-3/ +15

Mode Marche 33,6W (typ.)
Conserieien clnerse Tensi\on d'entrée Tensi\on d'entrée Tension d'entrée
(Méthode de test EnergyStar 5.0) CA a100VCA +/- |CAa115VCA +/- | CA a 230VCA +/-
5VCA, 50Hz +/-3Hz | 5VCA, 60Hz +/-3Hz | 5VCA, 50Hz +/-3Hz
Fonctionnement normal (typique) |28,38W 28,54W 2827W
Veille (En attente) 0,3W (typ.) 0,3W (typ.) 0,3W (typ.)
Eteint 0,3W (typ.) 0,3W (typ.) 0,3W (typ.)
Tension d'entrée Tension d'entrée Tension d'entrée
Dissipation thermique* CAa100VCA +/- |CAa115VCA +/- | CA a230VCA +/-
5VCA, 50Hz +/-3Hz | 5VCA, 60Hz +/-3Hz | 5VCA, 50Hz +/-3Hz
Fonctionnement normal 96,86 BTU/hr 97,41 BTU/hr 96,48 BTU/hr
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Veille (En attente)

1,023 BTU/hr 1,023 BTU/hr 1,023 BTU/hr

Eteint

1,023 BTU/hr 1,023 BTU/hr 1,023 BTU/hr

Voyant DEL d'alimentation

En mode : Blanc, mode En attente/Veille : Blanc (clignote)

Alimentation

Intégré, 100-240VCA, 50/60Hz

Produit avec socle (LxHxP)

550 x 421 x 180 mm

Produit sans socle (LxHxP)

550 x 339 x 34 mm

Produit avec socle 311 kg
Produit sans socle 2,06 kg
Produit emballé 543 kg

Plage de température (en fonc-
tionnement)

de 0°Ca 40 °C

Plage de température
(Hors fonctionnement)

de -20°C a 60°C

Humidité relative

de 20% a 80%

Utilisation : + 6 500 pieds (1 981m)

Altitude Hors fonctionnement : + 40 000 pieds (12 192m)
MTBF 30 000 heures

ROHS Oul

EPEAT Silver (www.epeat.net)

Emballage 100% recyclable

Substances spécifiques

Boitier 100% PVC sans BFR

EnergyStar

Approbations réglementaires

50

CE Mark, FCC Class B, SEMKO, UL/cUL, BSMI, GOST,
ISO 9241-307,TCO 5.2

Couleur Noir/Blanc, ou autres options de couleur selon le cas dans votre région
Finition Brillant
& Remarque

1. EPEAT Gold ou Silver n'est valide qu'aux endroits ou Philips a enregistré le produit.Visitez le site
www.epeat.net pour connaitre |'état de I'enregistrement dans votre pays.

2. Ces données sont sujettes a modifications sans préavis. Visitez www.philips.com/support pour
télécharger la derniére version de la brochure.
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4.1 Résolution et modes de
préréglage
El Résolution maximale

1920 x 1080 a 60Hz (Entrée analogique)
1920 x 1080 a 60Hz (Entrée analogique)

E Résolution recommandée
1920 x 1080 a 60Hz (Entrée analogique)

3147 720 x 400 70.09
3147 640 x 480 59.94
35.00 640 x 480 66.67
37.86 640 x 480 72.81
37.50 640 x 480 75.00
37.88 800 x 600 60.32
46.88 800 x 600 75.00
48.36 1024 x 768 60.00
60.02 1024 x 768 75.03
4477 1280 x 720 59.86

63.89 1280 x 1024 60.02
79.98 1280 x 1024 75.03
5594 1440 x 900 59.89
70.64 1440 x 900 7498
6529 1680 x 1050 59.95
67.50 1920 x 1080 60.00

& Remarque

Veuillez noter que votre moniteur fonctionne
de facon optimale a sa résolution native de
1920 x 1080 @ 60Hz. Pour un affichage optimal,
veuillez suivre cette recommandation quant a la
résolution.
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5. Gestion de I'énergie

Si vous disposez d'une carte vidéo compatible
VESA DPM ou d'un logiciel installé sur votre
PC, le moniteur va automatiquement réduire
sa consommation électrique lorsqu'il n'est
pas utilisé. En cas d'activation d'une touche
du clavier, de manipulation de la souris ou

de détection d'un autre appareil d'entrée, le
moniteur va automatiquement « se réveiller
». Le tableau suivant affiche la consommation
électrique et la signalisation de ladite fonction
d'économie d'énergie :

Mode VESA| Vidéo |H-sync | Vesync | Energie utilisée \(/;c;zlriuggt
. AC- .
Actif TIVE Oui Oui 33,6W (typ.) Blanc
' DE-
Veille (En Blanc
attent(e) SAC || Nem || [N <03W (p) (clignote)
TIVE &
DE- -
Eteint | SAC- | - - <03W (typ) DEIS@C'
TIVE

La configuration suivante est utilisée pour
mesurer la consommation électrique de ce
moniteur.

* Résolution native : 1920 x 1080

»  Contraste : 50%

*  Luminosité : 300 nits

» Température de couleurs : 6500k avec

motif blanc complet

© Remarque
Ces données sont sujettes a modifications sans
préavis.



6. Informations Concernant
les Réglementations

Lead-free Product

Lead free display promotes environ-
mentally sound recovery and disposal
¥ of waste from electrical and electro-
nic equipment. Toxic substances like
Lead has been eliminated and compliance with
European community’s stringent RoHs directive
mandating restrictions on hazardous substances
in electrical and electronic equipment have been
adhered to in order to make Philips monitors
safe to use throughout its life cycle.

CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006 (Safety requirement of
Information Technology Equipment).
EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).
EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).
EN61000-3-2:2006 (Limits for Harmonic
Current Emission).
EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

2006/95/EC (Low Voltage Directive).
2004/108/EC (EMC Directive).
2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive

for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following
standards
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1S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

GS EK1-2000:2009 (GS mark requirement).

prEN50279:1998 (Low Frequency Electric
and Magnetic fields forVisual Display).

MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).
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Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B
digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to pro-
vide reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instruc-
tions, may cause harmful interference to
radio communications.

However, there is no guarantee that interfe-
rence will not occur in a particular installa-
tion. If this equipment does cause harmful
interference to radio or television reception,
which can be determined by turning the
equipment off and on, the user is encou-
raged to try to correct the interference by
one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

e Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harm-
ful interference, and (2) this device must accept
any interference received, including interference
that may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils numé-
riques de class B,aux termes de I'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.
Cependant, rien ne peut garantir I'absence
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d'interférences dans le cadre d'une installa-
tion particuliére. Si cet appareil est la cause
d'interférences nuisibles pour la réception
des signaux de radio ou de télévision, ce qui
peut étre décelé en fermant I'équipement,
puis en le remettant en fonction, I'utilisateur
pourrait essayer de corriger la situation en
prenant les mesures suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

0 Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour les
connections avec des ordinateurs ou périphé-
riques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices a8 described in EN 55022, unless it is spaci-
cally stated that it i a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 metars). The user of the
davice is obligad to take all staps necessary o remove sources of interfarance to tals-
communication or other devicas.

Pokd neni na fypovém &tk potstase uvedena, # spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 5502 platl nésleduficl. Dojde-li k rullan! telskomunikatich nebo
finjich zafizani e uivatal povinnen provést takova opatfgni, atry nen odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the equip-
ment is in compliance with the protection usage
requirements of standards PN-93/T-42107 and
PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji

Urzdeenic powinne byt zasitane # poiazds 2 preylaczanyem obwodem ochronnye (gniazdo
Kalkiem ). Wapdlgracuface i sohq urzadzenia (kompuser, monitor, druksrkal powinny by sasilane
2 tegn samego drbdla.

Instalacja elekerycena pomiesscrenia powinn mwie
praneel swarciami, w pestaci berpiecanika o warto:
W el catkowitego wybserenia urzadzenia 2 siect zasilania, nalezy wyjné wivczkg kabla
easilajacega = poazdka, kidre powinno ssidowad s w pobliz urmJJanm:I!\t Batwi dosiepne.
Zaak bezpiecsefstwa "B” potwiendss podnosé uresdseia 2 wynaganiami bezpiecsehstva
whytkowania sawartyini w PN-ULTA2107 § PR-BOE-G

w przeworksie fzowym rezecrowa achrang
marmienavwe] e wicksej ni 164 (amperiuw).

Pozostale instrukcje bezpieczensiwa

* Niemaledy urywad wiyceek sdapterowych lub usuwaé kolka abwedu ackrornego 2 wiyeeki.
Jekeli Lu\m‘WIILJLJ LRy |:|1:\:\Jlural‘ra o naledy whyd preediuzace 3-pylowego 2
System kmpalerowy rnlny sabezpivcryt prred nagtymi, chwilow
ac eliminatora preepied, urradrenia dopasow
berzakidceniowe irinia zasilania.

tic nie leZalo na kablach systemu kompuierowego, arz aby kable nie
dzse tokna byloby na sie nadeptywad lub poryksd sig o nie.
inych plynbw s system komputerowy.

warostami lub spad-
X

Nie maleiy wpychad adnych preedmiotion do atwost sy
podar lub porpenie pridem, poprzez o

najdowad sig 2 dala od g

Tacyjnych. Nakezy un

karmpuler oriz umisszezanss kamputera w ciasmym migse bez mailiwobe eyrkalac peoi-

plerwy i

etz wokdl niego.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT NET-
LEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI IR-
ROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA DU
PASSE PA AT KONTAKTENE FOR ST@MTIL-
FORSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RRZHENERIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erflillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dun-
klem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder weni-
ger.

() ACHTUNG: BEIM AUFSTELLEN DIESES
GERATES DARAUF ACHTEN, DAB
NETZSTECKER UND NETZKABE-
LANSCHLUB LEICHT ZUGANGLICH
SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products produced and sold for China
market have to meet China RoHS request.
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7. Assistance clientéle et
Garantie

7.1 Politique de Philips relative aux
pixels défectueux des écrans
plats

Philips s'efforce de livrer des produits de la plus
haute qualité. Nous utilisons les processus de
fabrication les plus avancés de I'industrie et les
méthodes les plus strictes de contrdle de la
qualité. Néanmoins, des défauts au niveau des
pixels ou des sous-pixels sont parfois inévitables

dans les dalles TFT utilisées dans les écrans plats.

Aucun fabricant ne peut garantir que tous les
panneaux seront sans pixel défectueux, mais
Philips garantit que tout moniteur avec un
nombre inacceptable de défauts sera réparé
ou remplacé sous garantie. Cet avis explique
les différents types de défauts de pixels et
définit les niveaux de défauts acceptables pour
chacun des ces types. Pour bénéficier de la
réparation ou du remplacement sous garantie,
le nombre de défauts de pixels sur un panneau
TFT doit dépasser ces niveaux acceptables. Par
exemple, pas plus de 0,0004% des sous-pixels
d'un moniteur ne peuvent étre défectueux.

En outre, étant donné que certains types ou
combinaisons de défauts de pixels sont plus
remarqués que d'autres, Philips détermine des
niveaux de qualité encore plus élevés. Cette
garantie est valable dans le monde entier.

sous-pixel

R G B

pixel

Pixels et sous-pixels

Un pixel, ou élément d'image, est composé de
trois sous-pixels correspondants aux couleurs
primaires rouge, vert et bleu. Une image se
compose d'un grand nombre de pixels. Quand
tous les sous-pixels d'un pixel sont allumés, les
trois sous-pixels colorés apparaissent ensemble
comme un seul pixel blanc. Quand ils sont tous
éteints, les trois sous-pixels colorés apparaissent

ensemble comme un seul pixel noir. Les autres
combinaisons de sous-pixels allumés et éteints
apparaissent comme les pixels individuels
d'autres couleurs.

Types de défauts de pixels

Les défauts de pixels et de sous-pixels
apparaissent sur I'écran de différentes fagons. Il
existe deux catégories de défauts de pixels et
plusieurs types de défauts de sous-pixels dans
chaque catégorie.

Défauts de points brillants

Les points défectueux brillants sont des pixels
ou sous-pixels toujours allumés ou « activés
». Un pixel brillant est donc un sous-pixel qui
ressort du fond sombre de I'écran.Voici les
types de pixels brillants défectueux.

Un sous-pixel rouge, vert ou bleu allumé.

| ¢

Deux sous-pixels allumés adjacents :
- Rouge + Bleu =Violet
- Rouge +Vert = Jaune
- Vert + Bleu = Cyan (Bleu pale)

Trois sous-pixels adjacents allumés (un pixel
blanc).
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€ Remarque

Un pixel brillant rouge ou bleu a une luminosité
supérieure a 50 % par rapport aux pixels

environnants, tandis qu'un pixel brillant vert est
30 % plus lumineux que les pixels environnants.

Défauts de points sombres

Les points défectueux sombres sont des pixels

ou sous-pixels toujours noirs ou « éteints ». Un
pixel sombre est donc un sous-pixel qui ressort
du fond clair de I'écran.Voici les types de pixels
sombres défectueux.

DEFAUTS DES POINTS LUMINEUX

Proximité des défauts de pixels

Du fait que des défauts de méme type
provenant de pixels et sous-pixels proches les
uns des autres peuvent étre plus facilement
remarqués, Philips spécifie aussi des tolérances
pour la proximité des défauts de pixels.

Tolérances des défauts de pixels

Pour bénéficier, pendant la période de garantie,
d'une réparation ou d'un remplacement en
raison de défauts de pixels, le panneau TFT d'un
écran plat Philips doit avoir des défauts de pixels
et sous-pixels qui dépassent les tolérances
répertoriées dans les tableaux s.

NIVEAU ACCEPTABLE

1 sous-pixel éclairé 3
2 sous-pixels adjacents éclairés 1
3 sous-pixels adjacents éclairés (un pixel blanc) 0
Distance entre deux points lumineux défectueux* >15mm
Total des points lumineux défectueux, tous types confondus 3
POINTS NOIRS DEFECTUEUX NIVEAU ACCEPTABLE
1 sous-pixel noir 5 ou moins
2 sous-pixels noirs adjacents 2 ou moins
3 sous-pixels noirs adjacents 0
Distance entre deux points noirs défectueux* >15mm
Nombre total de points défectueux de tous types 5 ou moins
Nombre total de points lumineux ou noirs défectueux de tous 5 ou moins
types

© Remarque

1. 1 ou 2 sous-pixels adjacents = 1 point défectueux

2. Ce moniteur est conforme a la norme 1SO9241

-307 (15O9241-307 : Méthodes de test sur

I'exigence ergonomique, I'analyse et la conformité des écrans visuels électroniques)
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7.2 Assistance client & Garantie

Pour plus d'informations sur la garantie et le support additionnel pour votre région, veuillez consultez le
site wwwi.philips.com/support. Vous pouvez également contacter le service d'assistance a la clientéle de
Philips de votre région, a I'un des numéros ci-dessous.

Informations de contact pour la région EUROPE DE L'EST :

Pays ASC Numéro clientele Prix

Germany Siemens 1&S +49 01803 386 853 €009

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010

Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €0,10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €007

Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Informations de contact pour la région EUROPE CENTRAL ET EUROPE DE L'EST :

Centre d'ap-
Pays pel ASC Numéro clientéle
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV Ltd. +371 7460399
Lithuania NA UAB “Servicenet” +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
serbia & Mon- |\, Kim Tec doo. +381 11 20 70 684
tenegro
Slovenia NA PC H.and +386 1 530 08 24

NA Comel +380 562320045
Ukraine -

NA Topaz-Service Company +38 044 245 73 31
- NA CPS +7 (495) 645 6746 (for repair)

ussia

NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697

NA Serware +36 12426331
Hungary -

NA Profi Service +36 1 814 8080

Informations de contact pour la région AMERIQUE LATINE :

Pays

Brazil

Argentina

Centre d'appel

Vermont

Numéro clienteéle
0800-7254101

0800 3330 856

Informations de contact pour la Chine :

Chine

Numeéro clientele : 4008 800 008

Informations de contact pour I'AMERIQUE DU NORD :

Pays Centre d'appel ASC Numéro clientele
USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800)479-6696




Contact Information for APMEA region:

Country Call center ASC Consumer care number
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd | 1. - i Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
. , . . . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
South Korea | NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
Taiwan PCCWTele: leerecco 0800-231-099
services Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
Jnited Arab | 0 AL SHAHD COMPUTER LL.C | 00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
. ; +84 8 38248007 Ho Chi Minh City
Vietnam NA FZI Sft;v'ce Informatic Com- | g4 5113562666 Danang City
e S +84 5113.562666 Can tho Province
- ‘ (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no dllstrlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
s Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992

buy-out)
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Le bouton AUTO ne marche pas

8. Guide de dépannage et
Foire Aux Questions

* La fonction auto ne marche qu'en mode
VGA-Analog (VGA-Analogique). Si les
résultats ne sont pas bons, vous pouvez
faire un ajustement manuel avec le menu
OsD.

© Remarque
La fonction Auto ne marche pas dans le mode
DVI-Digital (DVI-Numérique) car elle est inutile

8.1 Recherches de causes de pannes

Cette page reprend les problemes pouvant
&tre corrigés par un utilisateur. Si le probleme
persiste méme apres avoir appliqué ces

corrections, contactez un représentant du
service client Philips.

El Problémes les plus fréquents

Aucune image (le voyant DEL d’alimentation
ne s'allume pas)

Assurez-vous d'avoir bien branché le
cordon d'alimentation dans une prise, et a
I'arriere du moniteur.

Puis contrélez le bouton marche/arrét a
I'avant du moniteur. S'il est en position OFF
, appuyez pour le mettre en position ON.

Aucune image (Le voyant DEL d’alimentation
est blanc)

Vérifiez que I'ordinateur est allumé.

Vérifiez que le cable signal est bien branché
sur votre ordinateur.

Assurez-vous que le cable du moniteur ne
présente pas de broches tordues du cété
connexion. Si c'est le cas, il faut réparer ou
remplacer le cable.

La fonction d'économie d'énergie est peut-
étre activée.

L'écran affiche

Attention

Check cable connection

Vérifiez que le cable du moniteur est bien
relié a votre ordinateur. (Veuillez également
vous référer au Guide de démarrage
rapide).

Vérifiez I'absence de broches tordues au
niveau du cable du moniteur.

Vérifiez que I'ordinateur est allumé.
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dans ce mode.

Signes visibles de fumée ou d'étincelles

N'effectuez aucun dépannage.
Débranchez immédiatement le moniteur
de la prise d'alimentation secteur pour
votre sécurité.

Contactez immédiatement le service-client
de Philips.

Problémes relatifs a I'image

L'image n'est pas centrée

Réglez la position de l'image en utilisant la
fonction « Auto » dans le menu OSD.
Réglez la position de I'image en utilisant
la fonction Phase/Clock of Setup (Phase/
Horloge d'installatio) dans les commandes
principales du menu a I'écran. Elle ne
fonctionne qu'en mode VGA.

L'image vibre sur I'écran

Controlez le branchement du cable signal
au niveau de la carte graphique ou du PC.

Un scintillement vertical apparait

Réglez I'image en utilisant la fonction «
Auto » dans le menu OSD.

Eliminez les barres verticales en utilisant
la fonction Phase/Clock of Setup (Phase/
Horloge d'installatio) dans les commandes
principales du menu a I'écran. Elle ne
fonctionne qu'en mode VGA.



Un scintillement horizontal apparait

*  Réglez I''mage en utilisant la fonction «
Auto » dans le menu OSD.

+  Eliminez les barres verticales en utilisant
la fonction Phase/Clock of Setup (Phase/
Horloge d'installatio) dans les commandes
principales du menu a I'écran. Elle ne
fonctionne qu'en mode VGA.

I'image apparait floue, imparfaite ou trop
sombre

* Réglez le contraste et la luminosité en
utilisant le menu a I'écran.

Une image rémanente, en surimpression ou
image fantdéme apparait lorsque I'alimentation
est coupée.

» L'affichage sans interruption d'image
statique ou immobile sur une longue
période peut engendrer une « rémanence
a l'extinction », également appelée « image
résiduelle » ou « image fantdbme » sur
votre écran. Ces images « rémanentes
», « en surimpression » ou « fantémes
» sont un phénomene bien connu de la
technologie des panneaux LCD. Dans
la plupart des cas, cette « rémanence a
I'extinction », ou « image résiduelle » ou «
image fantdéme » disparalt progressivement
une fois l'alimentation éteinte.

* Activez systématiquement un programme
économiseur d'écran en mouvement
lorsque votre écran n'est pas sollicité.

* Activez systématiquement une application
de rafraichissement périodique de votre
moniteur LCD pour afficher un contenu
statique fixe.

* Le fait de ne pas activer d'économiseur
d'écran ni d'application de rafraichissement
périodique de I'écran peut conduire a des
symptdmes de « rémanence a |'extinction
», ou d’ « image résiduelle » ou d' «
image fantdme » les plus graves, qui ne
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disparaissent pas et ne peuvent pas étre
réparés. Ce dommage n'est pas couvert
par votre garantie.

L'image apparait déformée. Le texte est flou
ou brouillé.

* Réglez la résolution d'affichage du PC sur
celle recommandée pour le moniteur.

Des points verts, rouges, bleus, sombres et
blancs apparaissent a I'écran

* Les points rémanents sont une
caractéristique normale du cristal liquide
utilisé dans la technologie d'aujourd'hui ;
veuillez lire la section relative aux pixels
défectueux pour plus de détails.

Le voyant « Marche » est trop puissant et me
géne.
* Vous pouvez ajuster le voyant « Marche

» en utilisant Configuration DEL
d'alimentation dans le menu OSD.

Pour une assistance plus approfondie, veuillez
consulter la liste des Centres d'information aux
clients et contacter un représentant du service
client Philips.

8.2 Questions fréquentes -
SmartControl Premium

Q1.  Jai remplacé le moniteur de mon
PC par un nouveau moniteur et
SmartControl Premium ne marche
plus. Que faire ?

Rallumez votre PC et vérifiez si
SmartControl Premium marche
correctement. Si ce n'est pas le cas,
vous devrez supprimer puis réinstaller
SmartControl Premium pour garantir la
bonne installation du pilote.

Rép.:

Les fonctions de SmartControl
Premium marchaient correctement
avant mais ne marchent plus
maintenant. Que faire ?

Q2.



Rép.:

Qs.

Rép.:

Si vous avez effectué les opérations
suivantes, il faudra peut-étre réinstaller
le pilote du moniteur.

Remplacez la carte graphique par une
autre

Mettez a jour le pilote vidéo

Activités sur le systéme d'exploitation, telles
que service pack ou patch

Exécutez la mise a jour de Windows ainsi
que le pilote du moniteur et/ou vidéo mis
a jour

Windows a été redémarré alors que le
moniteur était hors tension ou déconnecté.

Pour résoudre le probléme, cliquez avec le
bouton droit sur My Computer (Poste de
travail), puis sur Properties (Propriétés) ->
Hardware (Matériel)-> Device Manager
(Gestionnaire de périphériques).

Si'la mention « Plug and Play Monitor »
(Moniteur Plug-and-Play) accompagne
l'icéne du Monitor (moniteur), il vous
faudra procéder a une nouvelle installation.
Désinstallez simplement SmartControl
Premium et réinstallez-le.

Apreés avoir installé SmartControl
Premium, lorsque je clique sur l'onglet
SmartControl Premium, rien ne se
passe ou un message d'erreur apparait.
Que s'est-il passé ?

Il se peut que votre carte graphique ne
soit pas compatible avec SmartControl
Premium. Si votre carte graphique fait
partie des marques susmentionnées,
essayez de télécharger le pilote de la
carte graphique le plus récent depuis

le site Internet correspondant a ladite
marque. Installez le pilote. Désinstallez
SmartControl Premium, et réinstallez-le
a nouveau.

Si cela ne fonctionne toujours pas, c'est
que la carte graphique n'est pas prise
en charge.Veuillez visiter le site Web
de Philips pour Vérifier si une nouvelle
version du pilote de SmartControl
Premium est disponible.
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Q4.

Rép.:

Q5.

Rép.:

Lorsque je clique sur Product
Information (Informations produit),
toutes les informations n'apparaissent
pas. Pourquoi ?

Le pilote de votre carte graphique

n'est peut-&tre pas la toute derniere
version disponible et ne prend donc
pas totalement en charge l'interface
DDC/CI. Essayez de télécharger la toute
derniére version du pilote de la carte
graphique depuis le site Internet de la
marque de la carte. Installez le pilote.
Désinstallez SmartControl Premium et
réinstallez-le a nouveau.

Attention

Theft mode enabled

J'ai égaré mon code PIN pour la
fonction Systéme Theft Deterrence
(Antivol). Que faire ?

Le service client de Philips a le droit
de vous demander une preuve
d'identification et d'autorisation, pour
vérifier si vous étes le propriétaire 1égal
du moniteur.

8.3
Q1:

Rép.:

Questions générales

Lorsque j'installe mon moniteur, que

faire lorsque I'écran affiche « Cannot
display this video mode » (Impossible
d’afficher ce mode vidéo)?

Résolution recommandée pour ce
moniteur : 1920 x 1080 @ 60 Hz.

Débranchez tous les cables, puis branchez
votre PC sur le moniteur que vous utilisiez
précédemment.

Dans Menu Start (Démarrer) de
Windows, choisissez Settings/Control Panel
(Parametres/Panneau de configuration)
Dans Fenétre du Panneau de configuration,
sélectionnez I'icone Display (Affichage)



Q2:

Rép.:

Q3:

Rép.:

Q4.

Rép.:

Dans Panneau de configuration Display
(Affichage), sélectionnez I'onglet « Settings »
(Paramétres). Dans |'onglet Parameétres, dans
la bofte « desktop area » (zone bureau),
déplacez la réglette sur 1920 x 1080 pixels.

Ouvrez les « Advanced Properties »
(Propriétés avancées) et réglez le Taux de
rafraichissement sur 60 Hz. Cliquez ensuite
sur OK.

Redémarrez votre ordinateur, reprenez les
étapes 2 et 3 et vérifiez que votre PC est
bien réglé sur 1920 x 1080 @60 Hz.

Eteignez votre ordinateur. Débranchez
votre ancien moniteur puis reconnectez
votre moniteur LCD Philips.

Mettez votre moniteur sous tension, puis
allumez votre PC.

Quel est le taux de rafraichissement
recommandé pour le moniteur LCD?

Le taux de rafraichissement
recommandé pour les moniteurs LCD
est de 60Hz. En cas de perturbation au
niveau de I'écran, vous pouvez |'ajuster
sur 75Hz pour tenter de supprimer le
brouillage.

A quoi servent les fichiers .inf et .icm
sur le CD-ROM? Comment installer
les pilotes (.inf et .icm) ?

Il s'agit des fichiers correspondant au
pilote de votre moniteur. Suivez les
instructions de votre manuel d'utilisateur
pour installer les pilotes. Au moment
de I'installation de votre moniteur;
votre ordinateur peut vous demander
les pilotes du moniteur (les fichiers

inf et .icm) ou un disque contenant
les pilotes. Suivez les instructions pour
insérer le CD-ROM inclus dans cet
emballage. Les pilotes du moniteur (les
fichiers .inf et .icm) peuvent s'installer
automatiquement.

Comment ajuster la résolution ?

Le pilote de votre carte graphique et
le moniteur déterminent ensemble les

Q5:

Rép.:

Qé:

Rép.:

Q7.

Rép.:

Q8:

Rép.:

.
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résolutions disponibles.Vous pouvez
choisir la résolution voulue depuis le
Panneau de configuration de Windows®,
sous "Propriétés d'affichage".

Que faire si je m'embrouille pendant
les réglages du moniteur ?

Appuyez simplement sur le bouton OK,
puis sélectionnez « Reset » (Réinitialiser)
pour restaurer tous les parametres
d'origine.

L'écran LCD résiste-t-il aux rayures ?

En général, il est recommandé d'éviter
de soumettre la surface du panneau

a un choc excessif et de le protéger
contre les objets émoussés ou pointus.
Lorsque vous manipulez le moniteur,
assurez-vous de ne pas appliquer

de pression ou de force sur le c6té
panneau. Cela pourrait affecter vos
conditions de garantie.

Comment nettoyer la surface de
I'‘écran LCD ?

Pour un nettoyage normal, utilisez

un chiffon propre et doux. Pour un
nettoyage plus en profondeur; utilisez
de l'alcool isopropylique. N'utilisez pas
de solvant, comme l'alcool éthylique,
I'éthanol, I'acétone, I'hexane, etc.

Comment modifier le réglage des
couleurs sur mon moniteur ?

Vous pouvez modifier le réglage des
couleurs depuis la commande du menu
a |'écran. Suivez la procédure ci-dessous,

Appuyez sur « OK » pour afficher le menu
OSD (affichage a I'écran).

Appuyez sur la « Down Arrow » (Fleche
vers le bas) pour sélectionner |'option «
Color » (Couleur). Appuyez ensuite sur «
OK'» pour ouvrir le sous-menu de réglage
des couleurs ; il y a trois réglages indiqués
ci-dessous.



1. ColorTemperature (Température
de couleurs) : les six réglages sont 5
000K, 6 500K, 7 500K, 8 200K, 9 300K
et 11 500K. Avec un réglage dans de

température de 5 000K I'écran apparaft

« chaud », avec une tonalité rouge-

blanc, alors que la température 11 500K

est plus « froide », avec une tonalité
bleu-blanc.

2. sRGB:il s'agit d'un réglage standard
permettant d'assurer le bon échange
des couleurs entre différents appareils
(par exemple les appareils photos
numériques, les moniteurs, les
imprimantes, les scanners, etc.)

3. User Define (Défini par I'utilisateur)
:'utilisateur peut choisir son réglage
préféré des couleurs en ajustant le
rouge, le vert et le bleu.

© Remarque

Une mesure de la couleur de la lumiére

émise par un objet lorsqu'il est chauffé. Cette
mesure s'exprime en termes d'échelle absolue
(degrés Kelvin). Les températures Kelvin faibles,
comme 2 004K, sont rouges. Les températures
plus élevées, comme 9 300K sont bleues. La
température neutre est blanche, a 6 504K.

Q9: Est-il possible de connecter mon
moniteur LCD a n'importe quel PC,
station de travail ou Mac ?

Rép.:  Oui.Tous les moniteurs LCD Philips
sont compatibles avec les PC, les Mac
et les stations de travail standard.Vous
aurez peut-étre besoin d'un adaptateur
de cable pour brancher le moniteur
sur un systeme Mac. Nous vous
recommandons de contacter votre
représentant commercial Philips pour
plus d'informations.

Q10: Les moniteurs LCD Philips disposent-
ils de la fonctionnalité « Plug-and-Play
»?

Oui, les moniteurs sont compatibles
'Plug-and-Play' avec Windows 7,Vista ,

XP ,NT ,Mac OSX et Linux.

Rép.:
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Q11: Qu'appelle-t-on « image rémanente »,
« image en surimpression », « image
résiduelle », ou « image fantébme »
pour les écrans LCD?

Rép.: L'affichage sans interruption d'image

statique ou immobile sur une longue
période peut engendrer une «
rémanence a |'extinction », également
appelée « image résiduelle » ou « image
fantdme » sur votre écran. Ces images
« rémanentes », « en surimpression »
ou « fantémes » sont un phénomene
bien connu de la technologie des
panneaux LCD. Dans la plupart des cas,
cette « rémanence a I'extinction », ou «
image résiduelle » ou « image fantdme
» disparalt progressivement une fois
I'alimentation éteinte.

Activez systématiquement un
programme économiseur d'écran en
mouvement lorsque votre écran n'est
pas sollicité.

Activez systématiquement une
application de rafraichissement
périodique de votre moniteur LCD
pour afficher un contenu statique fixe.

) Avertissement

Le fait de ne pas activer d'économiseur d'écran
ni d'application de rafraichissement périodique
de I'écran peut conduire a des symptémes de
« rémanence a 'extinction », ou d' « image
résiduelle » ou d' « image fantdbme » les plus
graves, qui ne disparaissent pas et ne peuvent
pas étre réparés. Ce dommage n'est pas
couvert par votre garantie.

Q12: Pourquoi mon Affichage ne me permet
pas d'obtenir un texte clair, le contour
des caractéres affichés n'est pas net ?

Rép.:  Votre moniteur LCD fonctionne de

facon optimale en utilisant la résolution
1920 x 1080 @60Hz. Pour un affichage
optimal, utilisez cette résolution.
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